
SurvNET Lesson One 

- Processing an Assumed Coordinate System 2D Total 
Station Network

This tutorial is divided into two lessons covering the process of reducing and adjusting 
raw survey data into final adjusted coordinates, using the SurvNET program. The tutorial 
will describe the reviewing and editing of the raw data prior to the processing of the raw 
data. Next, the least squares project settings will be described, and then the final report 
generated from the least squares processing will be be reviewed. This tutorial will review 
both a total station only project, and a project that combines both total station and GPS 
vectors. 

The raw data files associated with this tutorial is located in the Carlson2007\Data folder, 
under the installation folder on your computer (example: \Carlson2007\DATA).

1  The easiest way to start the program is to select SurvNET from the Survey menu. This 
opens the SurvNET window and program. 

2  The first step is to open an existing project or create a new project. We will open an 
existing project. Choose Open Project from the File menu. Navigate to the 
\Carlson2007\DATA\ folder and open the SurvNetTut01 project.

3  Learning the meaning and implications of the different project settings is the most 
critical initial step in learning how to use SurvNET. Let's review the different project 
screens. Choose Project from the Settings menu. 

Least Squares Settings

4  The Network Least-Squares Settings dialog box is displayed. In this dialog, the 
different settings required for the Least Squares reduction are available in the different 
tabbed dialog boxes. When all of the settings are set as desired, press OK to save the 
changes to the project settings, or press Cancel to return to the raw data editor without 
saving any project settings. For the purpose of this tutorial, the Coordinate System 
settings tab should look as follows before proceeding to the next step. To use an assumed 
coordinate system, the 'Local' Coord. System needs to be checked, and the 2D,1D 
Adjustment Model must be chosen. When using a local coordinate system, the distance 
units are not important other than for display purposes in the report. Computing elevation 



factors and performing Geoid modeling is not applicable to assumed datums. Notice that 
in this example we are not performing a vertical adjustment.

For more information on the content of this dialog box section, please review the 
SurvNET chapter of this manual.

5  Choose the 'Input Files' tab. This is the section of the Settings dialog box where you 
define the data files that make up the project. You can have multiple raw files in a single 
project. The ability for multiple raw files allows flexibility in collecting the data and 
processing large projects. It is typically easier in a large project to analyze and edit 
subsets of the total project, before combining all the data for a final adjustment. Notice 
that since we are working in a local coordinate system and using the 2D,1D Adjustment 
Model, GPS vectors cannot be incorporated into this project.

Note: The sample tutorial project has the input raw file in the default data folder of 
C:\Carlson2007\DATA. If you have a different data directory, then set the correct data 
file by highlighting the default file, pick Delete and then pick Add and select 
SurvNetTut01.rw5 from your data folder.

6  Choose the Preprocessing tab to review the least squares preprocessing settings. For 
the purpose of this tutorial, the Preprocessing settings should look as follows before 
proceeding to the next step. Preprocessing consists of reducing and averaging all the 
multiple measurements, applying curvature and refraction correction, reducing the 
measurements to grid if appropriate, and computing unadjusted traverse closures if 
appropriate. Much of the data validation is performed during the preprocessing step.

For more information on the content of this dialog box section, please review the 
SurvNET chapter of this manual.

7  Choose the Standard Errors tab to review the standard error settings. The standard 
error settings should look as follows before proceeding to the next step. Standard errors 
are an estimate of the different errors you would expect to obtain based on the type 
equipment and field procedures you used to collect the raw data. For example, if you are 
using a 5 second theodolite, you could expect the angles to be measured within +/- 5 
seconds (Reading error). 



For more information on the content of this dialog box, please review the SurvNET 
chapter of this manual.

8 Choose the Adjustment tab to review the Adjustment settings. The Adjustment 
settings should look as follows before proceeding to the next step. The Adjustment 
settings affect how the actual least squares portion of the processing is performed. 
Additionally, from the screen the user can set whether ALTA reporting is performed.

9   Choose the Output Options tab to review the output settings. For the purpose of this 
tutorial, the Output Options settings should look as follows before proceeding to the next 
step. These settings apply only to the output of data to the report files. These settings do 
not affect computational precision. Press OK to return to the main SurvNET screen.

General Rules For Collecting Data for Use in Least Squares Adjustments

Least squares is very flexible in terms of how the survey data needs to be collected. 
Generally speaking, any combination of angles and distances, combined with a minimal 
amount of control points and azimuths, are needed. This data can be collected in any 
order. But there needs to be at least some redundancy in the measurements. 

Redundant measurements are measurements that are in excess of the minimum number 
needed to determine the unknown coordinates. Redundancy can be created by including 
multiple GPS, and other control points, within a network or traverse. Measuring angles 
and distances to points in the network that have already been located create redundancy. 
Running additional cut-off traverses, or additional traverses to existing control points, 
creates redundancy. Following are some general rules and tips in collecting data for least 
squares reduction.

 Backsights should be to point numbers. Some data collectors allow the user to 
backsight an azimuth not associated with a point number. SurvNET requires that 
all backsights be associated with a point number. 

 There has to be at least a minimum amount of control. There has to be least one 
control point. Additionally, there needs to be either one additional control point or 
a reference azimuth. Control points can be entered in either the raw data file, or 
there can be a supplemental control point file containing the control point. 
Reference azimuths are entered in the raw data file. The control points and 
azimuths do not need to be for the first points in the raw file. The control points 
and azimuths can be associated with any point in the network or traverse. The 
control does not need to be adjacent to each othere. It is permissible to have one 
control point on one side of the project, and a reference azimuth on the other side 
of the project. 



 At least one of the control points needs to be occupied. There may be situations 
where no control point is ever occupied in the network, but only backsighted. In 
these situations, a preliminary value for one of the occupied points needs to be 
computed and entered as a floating point control point. 

 Some data collectors do not allow the surveyor to shoot the same point twice 
using the same point number. SurvNET requires that all  measurements to the 
same point use a single point number. The raw data may need to be edited after it 
has been downloaded to the office computer to insure that points are numbered 
correctly.

 The majority of all problems in processing raw data are related to point number 
problems. Using the same point number twice to different points, not using the 
same point number when shooting the same point, misnumbering backsights or 
foresights, and misnumbering control points are all common problems. 

 It is always best to explicitly define the control for the project. A good method is 
to put all the control for a project into a separate raw file. A big source of 
problems with new users is a misunderstanding in defining their control for a 
project. 

 Some data collectors may have preliminary unadjusted coordinates included with 
the raw data. These coordinate records should be removed from the raw file. The 
only coordinate values that should be in the raw file are the control points. 

 When a large project is not processing correctly, it is often useful to divide the 
project into several raw data files and debug and process each file separately as it 
is easier to debug small projects. Once the smaller projects are processing 
separately, they can be combined for a final combined adjustment.

Reviewing and Editing the Raw data

10  To review or edit the raw data, choose the Edit Raw Files command from the Tools 
menu.

11  If there are problems with the raw data, such as point numbering problems or 
incorrect rod heights, the raw data can be edited from this dialog. See the section on the 
raw data editor in the Carlson documentation to learn the details of the editor. Review the 
following Standard Errors and Control Points section before exiting the raw data editor. 

Standard Errors and Control Points

The default standard errors for points are defined in the Standard Errors sheet of the 
Settings dialog box. There are times when the default values may need to be overridden. 
For example, the control may be from GPS and the user has differing standard errors for 
his various GPS points. Or maybe some of the control points were collected with RTK 



methods, and other GPS points collected with more accurate static GPS methods. 
Standard error for individual points can be inserted into the raw data file. The following 
is the menu option used to insert standard errors into the raw file. Notice in the above raw 
data file that points TR1 and TR100 are the control points for this project. Also, notice 
there is a standard error record, CSE,  preceding the control points. 

The CSE record has the character '!' in the N,E,& Z field. The character '!' designates that 
all following control points will be fixed. Points that are fixed will not be adjusted during 
the adjustment. Placing a very small standard error on a control point is almost equivalent 
to fixing the point. Points can also be designated to be floating points by using the '#' 
character. The only practical use of creating a floating point is if SurvNET cannot 
compute preliminary coordinates because no control point is occupied. The surveyor can 
compute a preliminary value for one of the occupied points, and insert that point as a 
floating point. The floating point will be adjusted, and no weight will be given to the 
floating coordinate values. 

Standard error records effect all the records that follow the standard error record. To 
revert the standard errors back to the default values, a CSE record can be inserted 
containing the '*' character. In the following example, point TR1 has been designated as a 
fixed point. TR100 has a north standard error of .02 and and east standard error of .01. 
Following the TR100 point record there is a CSE record containing the '*' character. So, 
if there were any control points further down in the raw data file they would use the 
default standard errors as set in the project settings dialog box.

There may be times when non-control standard errors need to be overridden for certain 
measurements. For example, if fixed tripods were used for backsights and foresights for 
part of the traverse, and hand-held rods were used for another portion of the traverse, it 
would be appropriate to have differing 'Rod Ctr' standard errors for the different sections 
of the raw data. 

Standard errors for angles and distances can also be inserted into the raw data file using 
the Add menu options Setup Standard Error and Measurement Standard Error. The 
standard errors set by these inserted records override the default standard errors. In the 
following example, a setup standard record, SSE record, has been inserted in record 12. 
The SSE record effects all setup data that follow until another SSE record is inserted. In 
the following example, the foresight rod centering error is set to .005, the total station 
centering error is set to .005, the total station meaure-up error is set to .005 and the 
foresight measure-up error is set to .005.



The following is another example where it would be appropriate to insert a measurement 
standard error record, MSE, into the raw data. If two different total stations with different 
accuracy specifications were used to collect the data, it would be approriate to have 
different standard errors for the different sections of the raw file, depending on which 
total station was used to collect the data. In the following example, a MSE record has 
been inserted for record 27. The horizontal pointing and reading error has been changed 
to 5 seconds, and the vertical pointing and reading error has been changed to 10 seconds. 
The inserted MSE record will effect all following raw data until another MSE is inserted.

Least Squares Processing

12   After exiting the raw data editor, we are ready to perform the least squares 
adjustment. From the Process menu, choose the Network Adjustment option. 

The least squares adjustment is performed, and the results from the adjustment are
displayed. If the solution converged correctly, the report should look similar to the 
following window. If there were errors or the solution did not converge, an error message 
dialog will be generated.

If there are errors, you will need to return to the raw data editor to review and edit the raw 
data. Since the tutorial example should have converged, we will next review the reports 
generated by the least squares adjustment. There are four windows created by the least 
squares program during processing. These files include the .err file, which contains any 
errors or warnings that were generated during processing. The .rpt file is the primary least 
squares report file summarizing the data and the results from the adjustment. An .out file 
is created containing a listing of the final coordinates. There is also a Graphics window 
that is displayed. The graphic window is temporary and useful only for seeing the results 
of the survey. To bring up the Graphics window, choose under the Window menu the 
Graphics command, or click the View Graphics icon on the toolbar.

Relative Error Ellipses

Relative error ellipses are a statistical measure of the expected error between two points. 
Regular error ellipses are a measure of the absolute error of a single point. Some survey 
accuracy standards such as the ALTA standards state the maximum allowable error 
between any two points in a survey. Relative error ellipses can give you this information. 



There is a more detailed ALTA reporting feature in SurvNET. See the manual for 
additional information on creating an ALTA report.

13  Press the Relative Error Ellipse toolbar icon button, or choose, off of the Tools menu, 
Relative Error Ellipse. Enter TR3 and TR7 in the From Pt. and To Pt. fields. Press OK to 
calculate. The dialog box should look as follows.

At the 95% confidence level there should only be around .02 feet of error between points 
TR3 and TR7. If you need to compute relative error ellipses for sideshots make sure the 
"Enable sideshots for error ellipse" toggle is set in the Adjustment tab of the 
Settings/Project dialog box.

Review of the Least Squares Report

14  In this section, the different sections of the least squares report are explained. If the 
Least Squares Report is not already showing, choose the Window menu and select the 
Least Square Report item. The report viewer has tabs to quickly access different sections 
of the report. 

Preprocessing and Header Information

The following excerpt from the report shows the header information and the 
preprocessing results. The header information consists of the date and time, the input and 
output file names, the coordinate system, the curvature/refraction setting, maximum 
iterations, and distance units.

During the preprocessing process, multiple angles are reduced to a single angle and 
multiple slope distances, vertical angles, HI's, and rod heights are reduced to a single 
horizontal distance and vertical difference. During this process the horizontal angle, 
horizontal distance, and vertical difference spreads are computed. If the spreads exceed 
the tolerance settings from the Settings dialog box, then a warning message is displayed 
showing the high and low measurement and the difference between the high and low 
measurement.

Unadjusted Measurements

The following excerpt from the report shows the unadjusted measurements. 
Measurements consist of some combination of control X, and Y, horizontal distances, 
horizontal angles, and azimuth measurements. These measurements consist of a single 
averaged measurement. For example, if multiple distances were collected between two 



points during data collection, only the single averaged measurement is used in the least 
squares adjustment. 

Also, standard errors for the measurements are displayed in this section of the report. The 
standard errors are computed from the standard error setting in the Settings dialog box 
using error propagation formulas. The standard error of an angle that was measured 
several times would typically be lower than an angle that was measured only once.

If the data had been adjusted into NAD 83 coordinates both the ground distances and the 
grid distances would be displayed. The grid, elevation, and combined factor would also 
be displayed in this section of the report. 

Adjusted Coordinates

The next section of the report shows the final adjusted coordinates. Additionally, the 
computed standard errors of the coordinates are displayed. If this project was reduced to 
NAD 83, the final latitude and longitudes are also displayed. Error ellipses computed to 
the 95 percent confidence interval are also displayed.

Adjusted Measurements

The following section from the report shows the final adjusted measurements. This 
section is one of the most important sections to review when analyzing the results of the 
adjustment. In addition to the adjusted measurement, the residual is displayed. The 
residual is the amount of adjustment applied to the measurement. The residual is 
computed by subtracting the unadjusted measurement from the adjusted measurement. 

The standard deviation of the measurement is also displayed. Ideally, the computed 
standard deviation and residual and the standard error displayed in the unadjusted 
measurement would all be of similar magnitude. The standard residual is a measure of the 
similarity of the residual to the a-priori standard error. The standard residual is the 
measurements residual divided by the standard error displayed in the unadjusted 
measurement section. A standard residual greater than 2 is marked with an "*". A high 
standard residual may be an indication of a blunder. If there are consistently a lot of high 
standard residuals it may indicate that the original standard errors set in the Settings 
dialog box were not realistic.

Statistics



The next section displays some statistical measures of the adjustment including the 
number of iterations needed for the solution to converge, the degrees of freedom of the 
network, the reference variance, the standard error of unit weight, and the results of a 
Chi-square test.

The degree of freedom is an indication of how many redundant measurements are in the 
survey. Degree of freedom is defined as the number of measurements in excess of the 
number of measurements necessary to solve the network.

The standard error of unit weight relates to the overall adjustment and not to an 
individual measurement. A value of one indicates that the results of the adjustment are 
consistent with the a priori standard errors. The reference variance is the standard error of 
unit weight squared.

The chi-square test is a test of the "goodness" of fit of the adjustment. It is not an absolute 
test of the accuracy of the survey. The a-priori standard errors which are defined in the 
project settings dialog box or with the SE record in the raw data file are used to determine 
the weights of the measurements. These standard errors can also be looked at as an 
estimate of how accurately the measurements were made. The chi-square test merely tests 
whether the results of the adjusted measurements are consistent with the a priori standard 
errors. Notice that if you change the project standard errors and then reprocess the survey 
the results of the chi-square test change, even though the measurements themselves did 
not change. 

In our example the chi-square test failed at the 95% significant level. Our example failed 
the chi-square test on the low end, 52.6 is less than 60.5. Failing on the low end indicates 
that our data is actually better than expected compared to our a-priori standard errors. If 
we were to decrease the pointing and reading standard error in the Settings screen by 5-
10 seconds we would probably pass the chi-square. Also notice that if you change the 
standard errors by only 5-10 seconds and reprocess the data the final coordinates will not 
change significantly.

Sideshots

If the "Enable sideshots for relative error ellipses" is not set in in the Adjustment screen 
of the project settings screen, sideshots are computed separately after the adjustment is 
completed. 

If the project had valid elevation benchmarks and measured HI's and rod heights the 
project could have been defined to adjust elevations. When using the 2D/1D least squares 
model the horizontal and the vertical adjustments are separate least squares adjustment 



processes. As long as there are redundant vertical measurements the vertical component 
of the network can also be reduced and adjusted using least squares. In the vertical 
adjustment, benchmarks are held fixed. 

This is the final step in the adjustment. The final adjusted coordinates are now stored in 
the current project point database and can now be used for mapping and design.


